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MANUAL CONTENTS 

 

This manual is intended for the 3rd year students of Civil Engineering in the subject of CAD Lab. This 

manual typically contains practical/lab sessions related to the use of the latest versions of surveying and 

geotechnical engineering software, including both open-source and commercial applications, for 

enhanced understanding of modern civil engineering practices and analysis techniques. 

Students are advised to thoroughly go through this manual rather than only focusing on topics mentioned 

in the syllabus, as practical exposure to engineering software is essential for understanding, visualizing, 

and applying theoretical concepts in real-world civil engineering projects. 

The laboratory sessions are designed to help students gain hands-on experience in drafting, surveying 

data analysis, terrain modeling, and geotechnical problem-solving using advanced software tools. These 

practical exercises will also help students develop technical, analytical, and problem-solving skills 

required in professional engineering practice. 

Good Luck for your Enjoyable Laboratory Sessions. 

 

 

PREFACE 

This practical manual will be helpful for students of Civil Engineering for understanding the course from 

the point of view of applied aspects. Though all the efforts have been made to make this manual error 

free, yet some errors might have crept in inadvertently. Suggestions from the readers for the 

improvement of the manual are most welcomed. 
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VISION OF THE INSTITUTE 

 

 

“To become a leading institute of providing professionally competent and socially 

responsive technocrats with high moral values.” 
 

 

MISSION OF THE INSTITUTE 

 

 

● To create an eco-system for the dissemination of technical knowledge, to achieve academic 

excellence. 

● To develop technocrats with creative skills and leadership qualities, to solve local and global 

challenges. 

● To impart human values and ethics in students, to make them socially and Eco-friendly 

responsible 

 

.
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VISION OF THE DEPARTMENT 

To impart academic excellence in civil engineering field with emphasis on holistic development of the professional, 

while inculcating ethics, socially and professionally responsive technocrats. 

 

 

MISSION OF THE DEPARTMENT 

• M1 – To provide a comprehensive platform for academic expertise and proficiency. 

• M2 – To develop civil engineering professionals with creative skills and leadership qualities in order to face 

regional and global challenges. 

• M3 – To develop ethics in students in order to promote socially responsible environmental awareness with 

innovative thinking. 

 

. 
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Program Educational Objectives(PEOs ) of Department 

 

 

PEO 1: To develop capacities and proficiency in the field of Civil engineering field 

towards improving employability attitude.  

PEO 2: To develop multidisciplinary approach through sophisticated tools/information 

system, construction projects and data bases to meet the social requirements.  

PEO 3: To utilize basic knowledge in the actual working conditions as a contribution 

towards safe and sustainable society. 
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Program Outcomes:(PO) 
 

Graduates will be able to achieve  

 

• PO1: Engineering Knowledge 

 

Apply the knowledge of mathematics, science, engineering fundamentals, and engineering 

specialization to solve complex engineering problems.  

• PO2: Problem Analysis 

 

Identify, formulate, review research literature, and analyze complex engineering problems using first 

principles of mathematics, natural sciences, and engineering sciences.  

• PO3: Design / Development of Solutions 

 

Design solutions for complex engineering problems and design system components or processes that 

meet specified needs with appropriate consideration for public health, safety, cultural, societal, and 

environmental aspects.  

• PO4: Conduct Investigations of Complex Problems 

 

Use research-based knowledge and methods including design of experiments, analysis and 

interpretation of data, and synthesis of information to provide valid conclusions.  

• PO5: Modern Tool Usage 

 

Create, select, and apply appropriate techniques, resources, and modern engineering and IT tools, 

including prediction and modeling, with an understanding of their limitations.  

• PO6: The Engineer and Society 

 

Apply reasoning informed by contextual knowledge to assess societal, health, safety, legal, and 

cultural issues and responsibilities relevant to professional engineering practice.  

• PO7: Environment and Sustainability 

 

Understand the impact of professional engineering solutions in societal and environmental contexts 

and demonstrate knowledge of sustainable development.  

• PO8: Ethics 

 

Apply ethical principles and commit to professional ethics, responsibilities, and norms of engineering 

practice.  

• PO9: Individual and Team Work 

 



 

7 

 

        

 
BABU BANARASI DAS  

INSTITUTE OF TECHNOLOGY & MANAGEMENT 
Affiliated to Dr A P J Abdul Kalam Technical University (AKTU College Code- 054) 

Approved by All India Council for Technical Education (AICTE) 
Website: www.bbditm.ac.in  /  e-mail: director@bbdnitm.ac.in 

Phone Number: +91 – (522) – 6196222 / 6196223 / 6196305  (VPN No. 723) 
Vision of the Institute 
“To become a leading institute of providing 
professionally competent and socially 
responsive technocrats with high moral values." 

Mission of the Institute 
 To create an eco-system for the dissemination of technical knowledge, to achieve academic 

excellence. 
 To develop technocrats with creative skills and leadership qualities, to solve local and global 

challenges. 
 To impart human values and ethics in students, to make them socially and Eco-friendly 

responsible. 
Function effectively as an individual and as a member or leader in diverse teams and multidisciplinary 

settings.  

• PO10: Communication 

 

Communicate effectively on complex engineering activities with the engineering community and 

society through reports, presentations, and clear instructions.  

• PO11: Project Management and Finance 

 

Demonstrate knowledge and understanding of engineering management principles and apply them to 

manage projects and multidisciplinary environments.  

• PO12: Life-long Learning 

 

Recognize the need for and have the preparation and ability to engage in independent and life-long 

learning in the broadest context of technological change. 

 

 

 

 

 

 

 

Program Specific Outcomes(PSOs) of the Department 
 
• PSO 1: Graduates shall be able to apply critical thinking in research, design, analysis and 

implementation of Civil Engineering problems.  

• PSO2: Graduate shall be able to inculcate the idea of sustainability in engineering solution to meet 

real world Challenges.  
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Course Evaluation Scheme 

 

Sr 

No 

Subject 

Code 

Subject 

Name 

Periods Evaluation Scheme 

Total Credit 

L T P 
Sessional Assessment 

PE 
CT TA PS 

1. BCE551 CAD Lab 0 0 2 - 50 - 50 100 1 

 

Course Objectives: 
The teacher will explain: 

1. To develop practical knowledge and hands-on experience in using the latest geotechnical, structural, 

and surveying software for civil engineering applications. 

2. To understand the analysis, modeling, drafting, and interpretation of engineering data using open-

source and commercial software tools. 

3. To enhance technical, analytical, and problem-solving skills through the application of modern 

engineering software in real-life civil engineering projects. 

 

 

Pre- requisite: Basic knowledge of Civil Engineering drawing, surveying concepts, geotechnical engineering 

principles, soil mechanics, computer operations, engineering data interpretation, and basic familiarity with QGIS 

and GEO5. 
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Course Outcomes (COs) 
 

Course Outcomes: The students should be able to: 
Bloom's 

Level 

CO1 Students will be able to work on Geo 5 /PLAXIS/STAAD Pro /Etabs software. L4 

CO2 Students will be able to work on QGIS software.  L4 

CO3 Students will be able to design and analyze Cantilever, Gravity wall retaining wall 

using geotechnical engineering software/design and analysis of multistory building 

using Structural analysis and design software.  

L4 

CO4 Students will be able to Geo reference a given map using QGIS softwares. L4 

CO5 Students will be able to Prepare maps using QGIS. L4 

 

CO-PO-PSO Mapping 

 
 PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PO11 PO12 PSO1 PSO2 

CO1 2 1 1 – 3 1 – – 2 2 - 1 1 1 

CO2 2 1 – – 3 – - – 2 2 – 1 1 1 

CO3 2 1 1 - 3 1 1 – 2 2 – 1 2 1 

CO4 1 – – – 3 – - – 2 2 – 1 1 - 

CO5 1 1 – 2 3 1 1 – 2 2 – 1 1 1 

Avg. 1.6 1 1 2 3 1 1 - 2 2 - 1 1.2 1 

 
The extent of mapping is as follows: 1 for low, 2 for moderate, 3 for high &”-” for No correlation 

between CO & PO. 
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List of Experiments 

 

S. No. Experiment 
1.  Working on latest version of geotechnical engineering software, structural engineering 

software (Open source/commercial software). 

2.  Working on latest version of surveying software (Open source/commercial software). 

 
 

 

Beyond Syllabus: 

 

NA 
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INDEX 

 
S. 

No. 

Name of the 

Experiment 

 

CO 

 

BTL 

Lab 

Conduction 

Date 

Remark/ 

Grade/ 

Marks 

Faculty Signature with Date 

1.  GEO5 

Interface Study 

CO1 L2    

2.  Bearing 

Capacity 

Analysis 

CO2 L3    

3.  Slope Stability 

Analysis 

CO2 L4    

4.  Retaining Wall 

Design 

CO3 L3    

5.  ETABS 

Software 

Interface Study 

and Basic 

Structural 

Modeling 

 

 

CO1 

 

 

L4 

   

6.  Foundation 

Analysis 

CO2 L4    

7.  QGIS Interface 

Study 

CO4 L2    

8.  Contour Map 

Preparation 

CO5 L3    

9.  Layer 

Management 

CO5 L3    

10.  Coordinate 

Plotting 

CO5 L3    

11.  Spatial Data 

Analysis 

CO3 L4    
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Software’s required: 

GEO5, QGIS, STAAD.Pro, ETABS, Windows Operating System. 

 

Hardware’s required: 
Computer System with Intel i3/i5 Processor, minimum 4 GB RAM, minimum 20 GB free storage 

space, mouse, keyboard, internet connectivity, printer/plotter (if required). 
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Do’s 

1. Follow the laboratory instructions carefully.  

2. Maintain proper handling of computer systems and software.  

3. Save work regularly during practical sessions.  

4. Use licensed/open-source software properly.  

5. Keep the laboratory clean and disciplined.  

6. Shut down the system properly after use. 

 

 

 

                             Don’ts 

 
1. Do not install unauthorized software.  

2. Do not change system settings without permission.  

3. Do not delete laboratory files or data.  

4. Do not use external storage devices without permission.  

5. Do not mishandle computer hardware or accessories.  

6. Do not leave the computer system running unattended. 
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Detailed Lab Manual (Geotechnical Engineering & GIS Lab) 
Experiment 1: GEO5 Interface Study 

Objective 

To study the GEO5 software interface, understand its tools, menus, and various geotechnical analysis 

modules used in civil engineering design. 

Theory 
GEO5 is a professional geotechnical engineering software package widely used for the design and 

analysis of soil-structure interaction problems. It is developed to assist civil and geotechnical 

engineers in performing accurate and reliable calculations based on internationally accepted 

engineering standards and geotechnical theories. 

The software consists of multiple specialized modules, each dedicated to solving specific engineering 

problems. Some commonly used modules include: 

• Spread Footing Design – Used for designing shallow foundations and checking bearing capacity, 

settlement, and reinforcement requirements.  

• Pile Foundation Analysis – Used for pile capacity, settlement, and pile group behavior analysis.  

• Retaining Wall Design – Used for analyzing earth pressure, wall stability, sliding, overturning, and 

structural safety.  

• Slope Stability Analysis – Used for evaluating natural and man-made slopes using methods such as 

Bishop, Fellenius, and Janbu.  

• Settlement Analysis – Used to estimate immediate and consolidation settlement in soil layers.  

• Earthquake Analysis Modules – Used for dynamic and seismic geotechnical design.  

GEO5 applies several standard geotechnical engineering theories and methods, including: 

• Terzaghi’s Bearing Capacity Theory for foundation design.  

• Coulomb and Rankine Earth Pressure Theories for retaining structures.  

• Bishop’s Method of Slices for slope stability calculations.  

• Elastic and Consolidation Settlement Theories for deformation analysis.  

• Limit State Design Principles for structural safety checks.  

The software offers an interactive graphical interface that allows users to input soil properties, define 

structural dimensions, apply loading conditions, and generate analytical results with diagrams and 

reports. Understanding the GEO5 interface is essential before performing any advanced geotechnical 

design because it helps users navigate efficiently, reduce errors, and interpret engineering outputs 

accurately. 
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Apparatus/Software Required 

The following tools and resources are required to perform this experiment: 

• Computer or Laptop with sufficient processing capability  

• GEO5 software installed and licensed  

• Operating system compatible with GEO5 (Windows recommended)  

• Sample soil investigation data  

• Internet connection (optional for updates and help documentation)  

• Laboratory manual for reference  

 

Procedure 
Step 1: Launching GEO5 Software 

Open the GEO5 software from the desktop shortcut or installed applications menu. Wait for the 

software to initialize and load the main dashboard. 

Step 2: Study of Main Interface 

Observe the various components of the GEO5 interface, including: 

• Title Bar: Displays project name and active module.  

• Menu Bar: Contains options such as File, Edit, View, Settings, Help, and Analysis tools.  

• Toolbar: Provides quick-access icons for common operations like save, open, calculate, and print.  

• Project Explorer: Displays project files and module hierarchy.  

• Workspace Area: Main area where data entry and graphical modeling are performed.  

• Status Bar: Shows calculation status and software messages.  

Step 3: Exploring the File Menu 

Open the File menu and study options such as: 

• New Project  

• Open Existing Project  

• Save Project  

• Import/Export Data  

• Print Reports  

• Close Project  

Create a sample project and save it in the desired folder. 

Step 4: Opening Different GEO5 Modules 

Access and open various modules to understand their purpose: 



 

16 

 

        

 
BABU BANARASI DAS  

INSTITUTE OF TECHNOLOGY & MANAGEMENT 
Affiliated to Dr A P J Abdul Kalam Technical University (AKTU College Code- 054) 

Approved by All India Council for Technical Education (AICTE) 
Website: www.bbditm.ac.in  /  e-mail: director@bbdnitm.ac.in 

Phone Number: +91 – (522) – 6196222 / 6196223 / 6196305  (VPN No. 723) 
Vision of the Institute 
“To become a leading institute of providing 
professionally competent and socially 
responsive technocrats with high moral values." 

Mission of the Institute 
 To create an eco-system for the dissemination of technical knowledge, to achieve academic 

excellence. 
 To develop technocrats with creative skills and leadership qualities, to solve local and global 

challenges. 
 To impart human values and ethics in students, to make them socially and Eco-friendly 

responsible. 
• Spread Footing  

• Retaining Wall  

• Slope Stability  

• Pile Foundation  

• Settlement Analysis  

Observe how each module has a separate interface tailored for specific engineering calculations. 

Step 5: Inputting Soil Parameters 

Navigate to the input panels and study how to enter geotechnical properties such as: 

• Soil type  

• Unit weight  

• Cohesion (c)  

• Angle of internal friction (φ)  
• Young’s modulus  

• Groundwater level  

Learn how these parameters influence calculations. 

Step 6: Defining Loading Conditions 

Enter structural loading data including: 

• Vertical load  

• Horizontal load  

• Moment  

• Eccentricity  

Observe how loading affects design outputs. 

Step 7: Running Analysis 

Click on the Calculate or Analyze button to run the geotechnical simulation. 

Step 8: Observing Results 

Review output sections such as: 

• Safety factor values  

• Bearing capacity results  

• Settlement values  

• Stability diagrams  

• Failure surfaces  

Pressure distribution graphs  
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Step 9: Report Generation 

Use the report generation feature to create detailed engineering reports containing: 

• Input data summary  

• Calculation steps  

• Graphical results  

• Design conclusion  

 

Observation 
During the experiment, the following observations were made: 

• GEO5 provides an intuitive and user-friendly graphical interface.  

• Navigation between modules is simple and efficient.  

• Different geotechnical analysis modules are available for specialized tasks.  

• Soil and load parameters can be entered systematically.  

• Graphical visualization improves understanding of engineering behavior.  

• Calculation results are generated quickly and accurately.  

• Detailed professional reports can be exported in printable formats.  

• Error-checking features help prevent incorrect data entry.  

 

Result 
The GEO5 software interface was successfully studied and understood. The major menus, tools, 

modules, input panels, and result sections were explored in detail. Familiarity with the GEO5 

environment was achieved, providing a strong foundation for performing advanced geotechnical 

engineering analysis and design in future experiments. 
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Figure 1: GEO5 Main Interface with Toolbar and Modules 

Experiment 2: Bearing Capacity Analysis 
Objective 

To determine the safe bearing capacity of soil using GEO5 software. 

Theory 

Bearing capacity refers to the ability of soil to support loads imposed by structures without 

undergoing shear failure or excessive settlement. It is one of the most important parameters in 

foundation design. The ultimate bearing capacity can be calculated using theories developed by 

Terzaghi, Meyerhof, and Hansen. GEO5 simplifies this process by allowing engineers to input soil 

properties such as cohesion (c), angle of internal friction (φ), and unit weight (γ), and then calculates 
ultimate and allowable bearing capacities. 

Apparatus/Software Required 

• GEO5 software 

• Soil test data 

• Foundation dimensions 

Procedure 

1. Open GEO5 and select the Bearing Capacity module. 

2. Enter soil properties: cohesion, friction angle, and unit weight. 

3. Input foundation dimensions and depth. 

4. Apply structural load conditions. 

5. Run the analysis. 

6. Examine ultimate and allowable bearing capacity results. 

Observation 

• Soil failure pattern can be visualized. 

• Bearing capacity values are automatically computed. 

Result 

The safe bearing capacity of the given soil was calculated successfully. 
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Figure 2: Bearing Capacity Analysis Result Screen 
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Experiment 3: Slope Stability Analysis 
Objective 

To evaluate slope safety and determine the factor of safety against slope failure. 

 

Theory 
Slope stability analysis is an essential part of geotechnical engineering used to assess whether a slope 

is stable or prone to failure. Slopes may be natural (such as hillsides and embankments) or man-made 

(such as highway cuttings, earth dams, and retaining embankments). Failure of a slope can occur due 

to several factors including: 

• Excessive gravitational forces acting on the soil mass  

• Weak soil strength or low cohesion  

• Increase in pore water pressure due to groundwater or rainfall  

• External loads such as buildings, vehicles, or surcharge loads  

• Earthquakes or vibrations  

The primary objective of slope stability analysis is to calculate the Factor of Safety (FoS), which 

represents the ratio of resisting forces (shear strength of soil) to driving forces (forces causing 

movement). 

Factor of Safety (FoS)=Resisting ForcesDriving ForcesFactor\ of\ Safety\ (FoS)=\frac{Resisting\ 

Forces}{Driving\ Forces}Factor of Safety (FoS)=Driving ForcesResisting Forces  

• FoS > 1.5 → Slope is considered stable and safe.  
• FoS = 1.0–1.5 → Slope is marginally stable and may require monitoring or reinforcement.  
• FoS < 1.0 → Slope is unstable and failure is likely to occur.  

Modern geotechnical software such as GEO5 Slope Stability uses advanced limit equilibrium 

methods to evaluate slope safety. Common methods include: 

1. Bishop Method 

A widely used method that assumes circular failure surfaces and provides accurate results for 

homogeneous soils.  

2. Fellenius (Swedish Circle) Method 

A simpler method used for preliminary analysis, assuming circular slip surfaces.  

3. Janbu Method 

Suitable for analyzing both circular and non-circular failure surfaces and layered soil conditions.  

The software automatically generates multiple possible slip surfaces and determines the critical slip 

surface, which gives the minimum factor of safety and represents the most likely failure path. 

 
Procedure 
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Step 1: Open the Slope Stability Module 

Launch the GEO5 software and select the Slope Stability Analysis module from the available 

geotechnical tools. 

Step 2: Define the Slope Geometry 

Create the geometric profile of the slope by entering dimensions such as: 

• Height of slope  

• Inclination angle  

• Length of slope  

• Bench dimensions (if any)  

The slope can be drawn manually or imported from CAD files. 

Step 3: Enter Soil Layer Properties 

Define the engineering properties of each soil layer, including: 

• Unit weight (γ)  
• Cohesion (c)  

• Angle of internal friction (φ)  
• Elastic modulus (if required)  

Multiple soil strata can be assigned different parameters depending on site conditions. 

Step 4: Add Groundwater Conditions 

If groundwater is present, define: 

• Water table level  

• Pore water pressure  

• Seepage conditions  

Groundwater significantly affects slope stability because it reduces effective stress and shear 

strength. 

Step 5: Apply External Loads 

Input surcharge loads such as: 
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• Buildings  

• Traffic loads  

• Retaining structures  

• Equipment loads  

These additional loads increase driving forces on the slope. 

Step 6: Select Analysis Method 

Choose the appropriate calculation method such as: 

• Bishop Simplified Method  

• Fellenius Method  

• Janbu Method  

Different methods may produce slightly different FoS values. 

Step 7: Generate Potential Slip Surfaces 

The software automatically generates several possible circular or non-circular failure surfaces and 

evaluates each one. 

Step 8: Run the Analysis 

Execute the slope stability calculation. GEO5 computes: 

• Critical slip surface  

• Minimum factor of safety  

• Stability diagrams  

• Graphical representation of failure zones  

Step 9: Interpret Results 

Analyze the graphical and numerical output to determine whether the slope is safe or requires 

stabilization measures such as retaining walls, soil nailing, drainage improvement, or slope flattening. 

 
Observation 

During the analysis, the following observations were recorded: 
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• The software successfully identified the critical slip surface representing the most probable failure 

path.  

• Multiple trial slip circles were generated and compared.  

• The minimum Factor of Safety (FoS) was displayed both numerically and graphically.  

• Soil layers and groundwater effects influenced overall slope stability.  

• Areas of potential failure were highlighted in the analysis graph.  

• Graphical output clearly showed the relationship between slope geometry and stability conditions.  

• Stability improved or reduced depending on soil parameters and loading conditions.  

 
Result 

The slope stability analysis was successfully performed using GEO5 Slope Stability software. The 

critical failure surface was identified, and the minimum factor of safety was calculated. Based on 

the obtained FoS value, the slope condition was evaluated as stable/unsafe. The analysis helps 

engineers design suitable remedial measures to ensure long-term slope safety and prevent landslides 

or structural failures. 

Slope Stability Analysis Graph 
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Experiment 4: Retaining Wall Design 
Objective 

To design a retaining wall and verify its safety against overturning, sliding, and bearing failure. 

Theory 
A retaining wall is a structure constructed to retain or support soil at different ground elevations 

where the natural slope of the ground cannot be maintained. Retaining walls are commonly used in 

highways, basements, bridge abutments, embankments, and hill-cut constructions. 

The primary purpose of a retaining wall is to resist the lateral earth pressure exerted by the backfill 

soil and any additional surcharge loads acting on the retained soil mass. 

The design of a retaining wall must ensure safety against the following major failure modes: 

1. Sliding Failure 

Sliding occurs when the lateral earth pressure acting on the wall exceeds the frictional resistance 

between the base of the wall and the foundation soil, causing the wall to move horizontally. 

The factor of safety against sliding is expressed as: 

FoSoverturning= Resisting Moment/Overturning Moment 

A typical acceptable value is: 

• FoS > 1.5 for safe design  

 
2. Overturning Failure 

Overturning happens when the lateral earth pressure creates a moment that causes the wall to rotate 

about its toe. 

The factor of safety against overturning is calculated as: 

FoSoverturning=Resisting MomentOverturning MomentFoS_{overturning}=\frac{Resisting\ 

Moment}{Overturning\ Moment}FoSoverturning=Overturning MomentResisting Moment  

Acceptable criteria: 
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• FoS > 2.0 for stability  

 
3. Bearing Capacity Failure 

Bearing failure occurs when the pressure beneath the wall foundation exceeds the allowable bearing 

capacity of the soil, leading to excessive settlement or shear failure. 

The design must ensure: 

• Maximum base pressure ≤ Allowable soil bearing capacity  
• Uniform or acceptable pressure distribution beneath the footing  

 
Earth Pressure Theories Used 

To calculate the lateral earth pressure, GEO5 commonly applies the following theories: 

Rankine Earth Pressure Theory 

This theory assumes: 

• Smooth wall surface  

• No wall friction  

• Homogeneous backfill soil  

It is commonly used for simple retaining wall designs. 

 
Coulomb Earth Pressure Theory 

This method considers: 

• Wall friction  

• Inclined backfill surfaces  

• Wall inclination  

It provides more realistic results for practical retaining wall analysis. 

 
Components of a Retaining Wall 
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A typical retaining wall consists of: 

• Stem: Vertical portion resisting earth pressure  

• Heel: Base slab extending under retained soil  

• Toe: Front projection of the base slab  

• Foundation/Base Slab: Supports the entire structure  

• Drainage System: Prevents water pressure buildup behind the wall  

Proper drainage is essential because water pressure can significantly increase lateral loads. 

 

Procedure 
Step 1: Open Retaining Wall Module 

Launch GEO5 software and select the Retaining Wall Design module from the available 

geotechnical analysis options. 

 
Step 2: Define Wall Geometry 

Create the retaining wall model by entering its dimensions, including: 

• Wall height  

• Stem thickness  

• Base width  

• Heel length  

• Toe length  

• Foundation depth  

The geometry can be customized according to project requirements. 

 
Step 3: Enter Backfill Soil Properties 

Input the engineering properties of the retained soil, such as: 

• Unit weight (γ)  
• Cohesion (c)  

• Angle of internal friction (φ)  
• Soil type classification  

These parameters are essential for calculating earth pressure accurately. 
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Step 4: Define Foundation Soil Parameters 

Enter the properties of soil beneath the wall foundation, including: 

• Bearing capacity  

• Density  

• Shear strength parameters  

These values are required for bearing capacity verification. 

 
Step 5: Apply Surcharge Loads 

Additional loads acting on the retained soil are specified, such as: 

• Traffic loads  

• Building loads  

• Equipment loads  

• Uniform surcharge pressure  

These loads increase lateral earth pressure on the wall. 

 
Step 6: Define Groundwater Conditions 

If groundwater is present, enter: 

• Water table level  

• Hydrostatic pressure conditions  

Water pressure behind the wall can greatly affect stability and must be included in design 

calculations. 

 
Step 7: Perform Stability Analysis 

Run the analysis to check: 

• Stability against sliding  

• Stability against overturning  

• Bearing pressure under foundation  

• Resultant force location  
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The software automatically computes factors of safety for each condition. 

 
Step 8: Review Structural Reinforcement 

If reinforced concrete retaining wall design is included, check: 

• Required steel reinforcement  

• Bending moments  

• Shear forces  

• Reinforcement detailing  

GEO5 provides optimized reinforcement recommendations. 

 
Step 9: Interpret Results 

Examine the graphical and numerical outputs, including: 

• Earth pressure diagrams  

• Moment diagrams  

• Base pressure distribution  

• Safety factor values  

• Wall displacement indicators  

If safety requirements are not met, modify wall dimensions and repeat analysis. 

 

Observation 

During the retaining wall design and analysis, the following observations were recorded: 

• The lateral earth pressure acting on the wall was calculated successfully.  

• Stability against sliding was verified.  

• Stability against overturning was checked and found satisfactory.  

• Bearing pressure under the foundation was within allowable limits.  

• The resultant force remained within the middle third of the base.  

• Reinforcement requirements were generated automatically.  

• Graphical outputs showed pressure distribution and structural behavior clearly.  

• The designed wall dimensions were adequate for the given loading conditions.  

 

Result 
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The retaining wall was successfully designed using GEO5 Retaining Wall software. All stability 

checks including sliding, overturning, and bearing capacity were performed and found to satisfy 

the required safety criteria. The reinforcement design was also verified, confirming that the retaining 

wall is structurally safe and suitable for construction under the given soil and loading conditions. 

 Figure 4: Retaining Wall Design Output 
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EXPERIMENT 05 

Study of ETABS Software Interface and Basic Structural Modeling 

Objective 

To study the latest version of ETABS software interface and understand its tools, menus, and 

applications in structural engineering analysis and design. 

 
Theory 

ETABS (Extended Three-Dimensional Analysis of Building Systems) is one of the most widely 

used commercial structural engineering software packages developed by Computers and 

Structures, Inc. (CSI). It is specifically designed for modeling, analyzing, and designing building 

structures such as residential buildings, commercial complexes, towers, and industrial structures. 

The latest version of ETABS provides an integrated environment for creating structural models, 

assigning material properties, applying loads, performing analysis, and designing structural elements 

according to various international design codes. 

Key features of ETABS include: 

• User-friendly graphical interface.  

• 2D and 3D structural modeling.  

• Automatic load calculations (dead load, live load, wind load, seismic load).  

• Finite Element Analysis (FEA) for accurate structural behavior prediction.  

• Design of beams, columns, slabs, and shear walls.  

• Dynamic analysis including response spectrum and time history analysis.  

• Detailed graphical and tabular output reports.  

• BIM compatibility and import/export with other software like AutoCAD and SAFE.  

ETABS is extensively used by civil and structural engineers to ensure safety, stability, and economic 

design of structures. 

 
Apparatus/Software Required 

• Computer/Laptop with Windows OS  

• Installed latest version of ETABS  

• Structural design data (building dimensions, material properties, load values)  

 
Procedure 

https://www.csiamerica.com/?utm_source=chatgpt.com
https://www.csiamerica.com/?utm_source=chatgpt.com
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1. Launch ETABS software.  

2. Study the main interface including toolbar, menu bar, model window, and status bar.  

3. Create a new model using the built-in model wizard.  

4. Define grid spacing and number of stories.  

5. Assign material properties such as concrete and steel.  

6. Define structural sections (beam, column, slab).  

7. Draw structural elements in plan and elevation views.  

8. Apply loads such as dead load and live load.  

9. Run structural analysis.  

10. Observe deformation, bending moment, shear force, and reaction diagrams.  

11. Review design results and generate reports.  

12. Save the project file.  

 
Observation 

• ETABS provides easy navigation between plan, elevation, and 3D views.  

• Structural elements can be modeled efficiently using graphical tools.  

• Analysis results are displayed in both graphical and numerical formats.  

• Design checks can be performed according to selected design codes.  

 
Result 

The ETABS software interface was studied successfully, and a basic structural model was created, 

analyzed, and interpreted using the latest version of the software. 
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Experiment 6: Foundation Analysis 
Objective 

To analyze foundation behavior under structural loading. 

 

Theory 
Foundation analysis is one of the most important aspects of geotechnical engineering because it 

determines how the loads from a structure are safely transferred to the underlying soil or rock. A 

properly designed foundation ensures the long-term stability, safety, and durability of buildings, 

bridges, towers, and other engineering structures. 

The primary function of a foundation is to: 

• Transfer structural loads safely to the soil  

• Prevent excessive settlement  

• Maintain structural stability  

• Avoid bearing capacity failure  

• Distribute loads uniformly to the supporting ground  

Foundation failure can occur due to: 

• Excessive settlement  

• Uneven or differential settlement  

• Bearing capacity failure  

• Soil shear failure  

• Groundwater effects  

• Weak or compressible soil layers  

Foundation analysis helps engineers understand how the soil responds under applied loads and 

whether the foundation dimensions are adequate. 

 

Important Parameters in Foundation Analysis 
1. Settlement Analysis 

Settlement refers to the downward movement of a foundation caused by compression of soil under 

loading. 

Settlement may be: 

• Immediate Settlement: Elastic deformation occurring immediately after loading  

• Consolidation Settlement: Time-dependent settlement due to expulsion of water from saturated soils  

• Differential Settlement: Uneven settlement that may cause structural cracks or tilting  
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Allowable settlement limits must not be exceeded to ensure serviceability. 

 
2. Stress Distribution 

Structural loads create stresses in the soil beneath the foundation. These stresses must be analyzed to 

determine how pressure spreads through different soil layers. 

Uniform stress distribution helps prevent localized failure and excessive deformation. 

 
3. Soil Bearing Pressure 

Bearing pressure is the pressure exerted by the foundation on the supporting soil. 

It must satisfy: 

qapplied≤qallowableq_{applied} \leq q_{allowable}qapplied≤qallowable  

Where: 

• qₐₚₚₗᵢₑd = Pressure exerted by foundation  

• qₐₗₗₒwₐbₗₑ = Safe allowable bearing capacity of soil  

If applied pressure exceeds allowable pressure, foundation failure may occur. 

 
4. Bearing Capacity 

Bearing capacity refers to the maximum load the soil can support without shear failure. 

Typical bearing capacity theories include: 

• Terzaghi’s Bearing Capacity Theory  

• Meyerhof Method  

• Hansen Method  

These methods are commonly integrated into GEO5 for accurate analysis. 

 
5. Load Combination Analysis 
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Foundations must withstand different types of loads, such as: 

• Dead loads (self-weight of structure)  

• Live loads (occupancy loads)  

• Wind loads  

• Seismic loads  

• Equipment loads  

GEO5 allows multiple load combinations to evaluate foundation performance under various 

conditions. 

 

Procedure 
Step 1: Select Foundation Analysis Module 

Open GEO5 software and choose the appropriate Foundation Analysis module depending on the 

type of foundation, such as: 

• Spread Footing  

• Strip Footing  

• Raft Foundation  

• Pile Foundation  

 
Step 2: Input Foundation Type and Dimensions 

Define the geometry and dimensions of the foundation, including: 

• Foundation length  

• Width  

• Depth below ground level  

• Thickness of footing  

• Shape (square, rectangular, circular)  

Proper dimensions are necessary for accurate load transfer analysis. 

 
Step 3: Enter Loading Values 

Input all structural loads acting on the foundation, such as: 

• Vertical load  
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• Horizontal load  

• Bending moments  

• Eccentric loading  

These loads may come from columns, walls, or structural frames. 

 
Step 4: Define Soil Properties 

Enter geotechnical parameters of the supporting soil, including: 

• Unit weight (γ)  
• Cohesion (c)  

• Angle of internal friction (φ)  
• Elastic modulus (E)  

• Poisson’s ratio (ν)  
• Soil stratification details  

These properties determine how the soil behaves under load. 

 
Step 5: Add Groundwater Conditions 

If groundwater exists near the foundation level, define: 

• Water table depth  

• Pore water pressure  

Groundwater can significantly reduce effective stress and soil strength. 

 
Step 6: Run the Analysis 

Execute the foundation analysis to calculate: 

• Settlement values  

• Soil pressure distribution  

• Bearing capacity utilization  

• Stress contours beneath foundation  

• Safety factors  

The software automatically performs numerical calculations and generates graphical outputs. 
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Step 7: Observe Pressure and Settlement Results 

Review the generated results, including: 

• Settlement graphs  

• Pressure distribution diagrams  

• Stress contour plots  

• Load transfer patterns  

Identify whether the foundation behaves within acceptable engineering limits. 

 
Step 8: Verify Safety Criteria 

Check whether: 

• Settlement is within allowable limits  

• Soil pressure does not exceed allowable bearing capacity  

• Factor of safety is satisfactory  

• No differential settlement risks exist  

If conditions are not satisfied, modify foundation dimensions and repeat analysis. 

 

Observation 

During the foundation analysis, the following observations were recorded: 

• Structural loads were successfully transferred to the supporting soil.  

• Soil pressure distribution beneath the foundation was displayed graphically.  

• Settlement values were calculated numerically.  

• Maximum settlement was within allowable design limits.  

• Bearing pressure remained below allowable soil capacity.  

• Stress distribution indicated uniform load transfer.  

• No significant differential settlement was observed.  

• Foundation stability was confirmed under the applied load combinations.  

 

Result 

The foundation analysis was successfully performed using GEO5 Foundation Analysis software. 

The behavior of the foundation under structural loading was evaluated through settlement analysis, 
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stress distribution, and soil pressure assessment. The obtained results confirmed that the foundation 

satisfies the required safety and serviceability conditions and is suitable for supporting the applied 

structural loads. 

Figure 5: Foundation Analysis Diagram 
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Experiment 7: QGIS Interface Study 
Objective 

To study the QGIS interface and understand GIS tools. 

Theory 

QGIS is a free and open-source Geographic Information System (GIS) software used for creating, 

editing, analyzing, and visualizing spatial data. It is widely used in engineering, environmental 

studies, urban planning, surveying, and resource management. 

QGIS supports both major types of geographic data: 

• Vector Data – Includes points, lines, and polygons (e.g., roads, buildings, boundaries).  

• Raster Data – Includes satellite images, digital elevation models, and scanned maps.  

The software provides powerful tools for: 

• Map creation and layout design  

• Spatial data editing and management  

• Coordinate system handling  

• Geoprocessing and spatial analysis  

• Data visualization through layers and symbols  

• Plugin integration for advanced GIS functions  

QGIS has a user-friendly graphical interface consisting of several important sections such as the 

Menu Bar, Toolbar, Browser Panel, Layers Panel, Map Canvas, and Processing Toolbox. 

Understanding these components is essential for efficient GIS work. 

 

Procedure 
Step 1: Launch QGIS Software 

Open the QGIS application from the desktop or start menu and wait for the main interface to load. 

Step 2: Explore the Menu Bar and Toolbar 

Study the options available in the menu bar such as: 

• Project  

• Edit  

• View  

• Layer  
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• Settings  

• Plugins  

• Vector  

• Raster  

• Processing  

Observe the toolbar icons used for quick access to common functions like zooming, selecting, and 

editing layers. 

Step 3: Study the Browser Panel and Layers Panel 

Examine the Browser Panel, which allows access to files, folders, databases, and GIS datasets. 

Study the Layers Panel, where loaded spatial data layers are displayed and managed. Layer 

visibility, order, and symbology can be controlled from this panel. 

Step 4: Understand the Map Canvas 

Observe the Map Canvas, which is the main working area where maps and spatial data are 

displayed. 

Practice basic navigation tools such as: 

• Zoom in / Zoom out  

• Pan map  

• Identify features  

• Measure distance and area  

Step 5: Explore Plugins and Processing Toolbox 

Open the Plugins menu to view additional tools that can extend QGIS functionality. 

Study the Processing Toolbox, which provides advanced geoprocessing tools such as: 

• Buffer  

• Clip  

• Merge  

• Intersect  

• Raster analysis  

Step 6: Load Sample GIS Data 

Import a sample shapefile or raster dataset and observe how layers are displayed and managed within 

the interface. 



 

40 

 

        

 
BABU BANARASI DAS  

INSTITUTE OF TECHNOLOGY & MANAGEMENT 
Affiliated to Dr A P J Abdul Kalam Technical University (AKTU College Code- 054) 

Approved by All India Council for Technical Education (AICTE) 
Website: www.bbditm.ac.in  /  e-mail: director@bbdnitm.ac.in 

Phone Number: +91 – (522) – 6196222 / 6196223 / 6196305  (VPN No. 723) 
Vision of the Institute 
“To become a leading institute of providing 
professionally competent and socially 
responsive technocrats with high moral values." 

Mission of the Institute 
 To create an eco-system for the dissemination of technical knowledge, to achieve academic 

excellence. 
 To develop technocrats with creative skills and leadership qualities, to solve local and global 

challenges. 
 To impart human values and ethics in students, to make them socially and Eco-friendly 

responsible. 

 

Observation 
During the study of the QGIS interface, the following observations were made: 

• The software interface is organized and user-friendly.  

• Different GIS tools are easily accessible through menus and toolbars.  

• The Layers Panel helps manage multiple spatial datasets efficiently.  

• The Map Canvas provides interactive visualization of geographic data.  

• Plugins and the Processing Toolbox offer advanced spatial analysis capabilities.  

• QGIS supports a wide variety of vector and raster file formats.  

 

Result 
The QGIS interface was studied successfully, and the main GIS tools and interface components 

were understood. The experiment provided basic knowledge of spatial data handling, map 

visualization, and geospatial analysis functions available in QGIS. 

Figure 6: QGIS Interface Screenshot 
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Experiment 8: Contour Map Preparation 
Objective 

To generate contour maps using elevation data in QGIS. 

Theory 
A contour map is a graphical representation of terrain where lines connect points of equal elevation 

above a reference level, usually mean sea level. These lines help visualize the shape, slope, and 

height variations of the land surface. 

Contour maps are widely used in: 

• Terrain and slope analysis  

• Drainage and watershed planning  

• Road and railway alignment  

• Site selection and land development  

• Civil engineering design  

In QGIS, contour maps are commonly generated from Digital Elevation Model (DEM) or other 

raster elevation datasets. The software processes elevation values and creates contour lines at a 

specified contour interval (e.g., 5 m, 10 m, or 20 m). 

Key terms: 

• DEM (Digital Elevation Model): Raster data representing ground elevation.  

• Contour Interval: Vertical difference between successive contour lines.  

• Index Contours: Major contour lines shown more prominently for easy reading.  

QGIS provides built-in tools for generating and styling contour maps efficiently. 

 

Procedure 
Step 1: Import DEM or Elevation Data 

Open QGIS and load the DEM or raster elevation dataset into the project using the Add Raster 

Layer option. 

Step 2: Open Contour Generation Tool 

Go to: 

Raster → Extraction → Contour 
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or use the Processing Toolbox and search for the Contour tool. 

Step 3: Set Contour Parameters 

Enter the required settings such as: 

• Input elevation raster  

• Contour interval (e.g., 10 m)  

• Output file location  

• Attribute field for elevation values  

Step 4: Generate Contour Lines 

Run the tool to create contour lines automatically from the elevation data. 

Step 5: Style the Contour Map 

Apply suitable symbology such as: 

• Different line colors  

• Label contour values  

• Highlight index contours  

This improves readability and presentation. 

 

Observation 

During the experiment, the following observations were made: 

• DEM data was imported successfully into QGIS.  

• Contour lines were generated based on selected elevation intervals.  

• Terrain variation and slope patterns became clearly visible.  

• Styled contour lines improved map interpretation.  

• The generated map can be used for further spatial analysis and engineering planning.  

 

Result 

The contour map was successfully generated using QGIS from elevation data. The experiment 

helped in understanding contour line creation, terrain representation, and the practical use of contour 

maps in geospatial and civil engineering applications. 
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Figure 7: Contour Map Generated in QGIS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

44 

 

        

 
BABU BANARASI DAS  

INSTITUTE OF TECHNOLOGY & MANAGEMENT 
Affiliated to Dr A P J Abdul Kalam Technical University (AKTU College Code- 054) 

Approved by All India Council for Technical Education (AICTE) 
Website: www.bbditm.ac.in  /  e-mail: director@bbdnitm.ac.in 

Phone Number: +91 – (522) – 6196222 / 6196223 / 6196305  (VPN No. 723) 
Vision of the Institute 
“To become a leading institute of providing 
professionally competent and socially 
responsive technocrats with high moral values." 

Mission of the Institute 
 To create an eco-system for the dissemination of technical knowledge, to achieve academic 

excellence. 
 To develop technocrats with creative skills and leadership qualities, to solve local and global 

challenges. 
 To impart human values and ethics in students, to make them socially and Eco-friendly 

responsible. 

Experiment 9: Layer Management 
Objective 

To manage and organize multiple GIS layers in QGIS. 

Theory 

In Geographic Information Systems (GIS), a layer is a collection of spatial data representing specific 

geographic features such as roads, rivers, land use, buildings, or elevation. Efficient layer 

management is essential for organizing large amounts of geospatial data and improving workflow 

during map preparation and spatial analysis. 

QGIS allows users to work with multiple types of layers, mainly: 

• Vector Layers – Represent geographic features using:  

o Points (e.g., wells, landmarks)  

o Lines (e.g., roads, rivers)  

o Polygons (e.g., districts, land parcels)  

• Raster Layers – Represent continuous data such as:  

o Satellite imagery  

o DEM (Digital Elevation Models)  

o Land cover maps  

Layer management involves several important operations, such as: 

1. Adding Layers 

Users can import multiple spatial datasets into QGIS from various formats like: 

• Shapefile (.shp)  

• GeoJSON  

• GeoTIFF  

• CSV with coordinates  

• Database connections  

 
2. Renaming and Grouping Layers 

Layers can be renamed for better identification and organized into groups or folders. Grouping helps 

manage complex projects containing many related datasets. 

 
3. Symbology and Styling 
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Each layer can be customized using different: 

• Colors  

• Line styles  

• Symbols  

• Labels  

• Transparency settings  

Proper symbology improves map readability and interpretation. 

 
4. Layer Visibility Control 

Users can turn layers on or off depending on the analysis requirement. This helps focus only on 

relevant information without cluttering the map. 

 
5. Layer Order Management 

The display order of layers is important because upper layers may hide lower layers. Proper 

arrangement ensures all important features remain visible. 

 
6. Attribute Table Access 

Each layer contains an attribute table storing descriptive information. Managing layers also includes 

viewing and editing attribute data linked to spatial features. 

Effective layer management makes GIS projects more organized, efficient, and easier to analyze. 

 
Procedure 

Step 1: Add Multiple Vector and Raster Layers 

Open QGIS and import several datasets using: 

Layer → Add Layer 

Load both vector layers (roads, boundaries, rivers) and raster layers (satellite images or DEM). 
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Step 2: Rename and Group Layers 

Rename each layer with meaningful names for easy identification. 

Create layer groups to organize similar datasets, such as: 

• Base Maps  

• Administrative Boundaries  

• Transportation  

• Hydrology  

 
Step 3: Apply Symbology 

Customize the appearance of each layer by applying suitable symbology: 

• Different colors for different features  

• Line thickness adjustments  

• Labels for important elements  

• Transparency settings for overlapping layers  

 
Step 4: Adjust Layer Display Order 

Drag and rearrange layers in the Layers Panel to control which layers appear above or below others. 

Ensure important features remain clearly visible on the map canvas. 

 
Step 5: Control Layer Visibility 

Use the visibility checkbox beside each layer to turn layers on or off and observe how the map 

changes. 

 
Step 6: Explore Attribute Information 

Open the attribute tables of selected layers and review feature-related information such as names, 

IDs, and classifications. 
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Observation 

During the experiment, the following observations were made: 

• Multiple vector and raster layers were successfully added into QGIS.  

• Layers were renamed and grouped for better organization.  

• Different symbology styles improved map clarity and visual appearance.  

• Adjusting display order helped avoid overlapping issues.  

• Layer visibility controls allowed selective viewing of map data.  

• Attribute tables provided additional information linked to spatial features.  

• Organized layer management made navigation and analysis easier.  

 
Result 

GIS layer management was performed successfully in QGIS. The experiment helped in 

understanding how to organize, style, and control multiple spatial datasets effectively. Proper layer 

management improved map readability, project organization, and overall efficiency in GIS-based 

analysis. 

Figure 8: Layer Panel in QGIS 
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Experiment 10: Coordinate Plotting 
Objective 

To plot coordinate points on a map using QGIS. 

Theory 
Coordinate plotting is the process of placing geographic locations on a map using numerical 

coordinate values. These coordinates define the exact position of a point on the Earth’s surface and 

are essential in mapping, surveying, navigation, and spatial analysis. 

The two commonly used coordinate systems are: 

• Geographic Coordinate System (GCS): Uses Latitude and Longitude values (e.g., 28.6139° N, 

77.2090° E).  

• Projected Coordinate System (PCS): Uses planar coordinates such as Easting and Northing in 

meters (e.g., UTM coordinates).  

In GIS, coordinate plotting is widely used for: 

• Mapping survey locations  

• Plotting GPS field data  

• Identifying infrastructure locations  

• Environmental monitoring  

• Site analysis and planning  

QGIS allows users to import coordinate data directly from files such as CSV (Comma Separated 

Values) and display them as spatial point layers on the map. To ensure accurate plotting, the correct 

Coordinate Reference System (CRS) must be defined. 

Important concepts include: 

• CSV File: A spreadsheet file containing coordinate values and related attributes.  

• CRS (Coordinate Reference System): Defines how coordinates relate to real-world positions.  

• Point Layer: A GIS layer showing plotted coordinate locations as points.  

• Shapefile: A commonly used GIS file format for storing spatial data.  

Proper coordinate plotting ensures accurate location representation and forms the basis for further 

GIS analysis. 

 

Procedure 
Step 1: Import CSV Containing Coordinates 

Open QGIS and select: 
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Layer → Add Layer → Add Delimited Text Layer 

Browse and select the CSV file containing coordinate data. 

 
Step 2: Assign Coordinate Fields 

Choose the appropriate fields for: 

• X Field → Longitude / Easting  
• Y Field → Latitude / Northing  

These fields determine where the points will be plotted on the map. 

 
Step 3: Define Coordinate Reference System (CRS) 

Select the correct CRS based on the coordinate format, such as: 

• EPSG:4326 (WGS 84) for latitude and longitude  

• UTM projection for projected coordinates  

Correct CRS selection ensures accurate point placement. 

 
Step 4: Display Point Data on Map 

Click Add to load the data. The coordinate points will appear on the Map Canvas as plotted 

locations. 

Zoom and inspect the points to verify correct placement. 

 
Step 5: Apply Symbology and Labels 

Customize the point appearance by changing: 

• Marker size and color  

• Point symbols  

• Labels using location names or IDs  

This improves map readability and presentation. 

 
Step 6: Save as Shapefile 

Right-click the plotted point layer and select: 
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Export → Save Features As 

Save the layer as a Shapefile or other GIS-supported format for future use. 

 

Observation 
During the experiment, the following observations were made: 

• The CSV file containing coordinate data was imported successfully.  

• Coordinate fields were assigned correctly.  

• The appropriate CRS ensured accurate point plotting.  

• All locations appeared correctly on the map canvas.  

• Symbology and labels improved visualization of the plotted points.  

• The point data was successfully converted into a GIS layer (shapefile).  

• The plotted coordinates can now be used for further spatial analysis and mapping.  

 

Result 

The coordinate points were successfully plotted in QGIS using the provided coordinate data. The 

experiment helped in understanding coordinate systems, CRS selection, and the process of converting 

tabular coordinate data into spatial GIS layers for mapping and analysis. 

Figure 9: Coordinate Plotting Output 
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Experiment 11: Spatial Data Analysis 
Objective 

To perform spatial analysis using GIS tools in QGIS. 

Theory 
Spatial data analysis is the process of examining geographic data to identify patterns, relationships, 

and spatial interactions between different features. It is one of the most important functions of 

Geographic Information Systems (GIS), allowing users to solve real-world problems through 

location-based analysis. 

Spatial analysis helps answer questions such as: 

• Which areas fall within a certain distance from a road or river?  

• Which regions overlap between different land-use zones?  

• What features are present inside a selected boundary?  

• How do different spatial layers interact with each other?  

QGIS provides a wide range of built-in tools for performing such analyses efficiently. 

Common Spatial Analysis Tools 

1. Buffer Analysis 

The Buffer tool creates zones around selected features at a specified distance. 

Examples: 

• Creating a 500 m buffer around roads  

• Identifying areas near rivers  

• Defining service zones around schools or hospitals  

 
2. Overlay Analysis 

Overlay combines multiple spatial layers to study their relationships. 

Common overlay operations include: 

• Union  

• Intersect  

• Difference  

This helps identify common or shared areas between datasets. 
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3. Clipping 

The Clip tool extracts only the portion of a dataset that falls within a selected boundary. 

Example: 

• Extracting roads within a district boundary  

• Cropping land-use data for a study area  

 
4. Intersection 

The Intersection tool identifies overlapping areas between two or more layers and creates a new 

layer containing only common features. 

Example: 

• Finding forest areas intersecting flood-prone zones  

• Identifying buildings within buffer zones  

Spatial analysis is widely used in: 

• Urban planning  

• Environmental impact studies  

• Transportation planning  

• Infrastructure development  

• Disaster management  

• Resource management  

 

Procedure 
Step 1: Load Required Spatial Datasets 

Open QGIS and import the necessary vector or raster layers such as: 

• Administrative boundaries  

• Roads  

• Rivers  

• Land-use maps  

• Infrastructure layers  

Ensure all layers use the same Coordinate Reference System (CRS). 

 
Step 2: Apply Buffer Tool 
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Open the Buffer tool from: 

Vector → Geoprocessing Tools → Buffer 

Select the desired layer and specify the buffer distance (e.g., 500 m or 1 km). 

Generate the buffer zones around selected features. 

 
Step 3: Perform Overlay Analysis 

Use overlay tools such as: 

Vector → Geoprocessing Tools → Union / Difference / Intersect 

Combine different layers to study spatial relationships and overlapping areas. 

 
Step 4: Perform Clipping 

Open the Clip tool and select: 

• Input layer  

• Clipping boundary layer  

Run the tool to extract only the required study area data. 

 
Step 5: Perform Intersection Analysis 

Use the Intersection tool to identify common areas between two spatial datasets. 

The output will show only overlapping geographic features. 

 
Step 6: Analyze Output Maps 

Examine the generated output layers on the Map Canvas. 

Apply suitable: 
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• Symbology  

• Labels  

• Layer styling  

to improve interpretation and presentation. 

 

Observation 
During the experiment, the following observations were made: 

• Required datasets were loaded successfully into QGIS.  

• Buffer zones were created accurately around selected features.  

• Overlay analysis helped identify relationships between multiple layers.  

• Clipping extracted only the required study area.  

• Intersection analysis successfully identified overlapping features.  

• Spatial patterns and geographic relationships became clearly visible.  

• Output maps provided useful information for planning and analysis.  

 

Result 
Spatial data analysis was successfully performed using QGIS. Various GIS tools such as buffer, 

overlay, clipping, and intersection were applied to analyze geographic relationships between spatial 

datasets. The experiment improved understanding of spatial problem-solving and demonstrated the 

practical importance of GIS analysis in engineering, planning, and environmental applications. 

Figure 10: Spatial Analysis Result 
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